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DEPARTMENT OF MECHANICAL ENGINEERING 
 

COMPUTER AIDED DESIGN LAB 
 

LIST OF EXPERIMENTS 

 
CAD LAB 

Sl.No. Experiment Name of Experiment Page 
No. 

1 Initiating the Graphics Package; Setting the paper size, space; 
setting the limits, units; use of snap and grid commands. 

3 

2 Drawing of primitives (Line, arc, circle, ellipse, triangle etc.) 5 

3 Drawing a flange. 10 

4 Drawing a bushing assembly. 13 

5 Dimensioning the drawing and adding text. 16 

6 Setting the layers and application of layers. 28 

7 Isometric and Orthographic projections. 31 

8 Viewing in three dimensions. 37 

9 Removal of hidden lines – Shading and Rendering. 40 

CAM LAB 
Sl.No. Experiment Name of Experiment Page 

No. 
1 Part programming preparation through AutoCAD. 45 

2 Part programming preparation through AutoCAD. 47 

3 APT part programming for 2D – contour. 48 

4 Machining of one job on CNC Machine Tool 57 
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 INTRODUCTION TO GRAPHICS PACKAGE 
 

 
The engineering drawing has been and is an integral part of industry and it is a 

link between engineering design and manufacturing. Information is quickly 

communicated in the form of drawings prepared according to prescribed drafting 

standards. 

 

What is Computer Aided Design? 

 The use of interactive graphics programs to develop 2D and 3D models, 

assemblies, part lists, and dimensional drawings of various components, structures or 

objects with the help of a computer is called Computer-Aided Design(CAD). The data 

generated by a CAD system can be directly utilized by a CAM (Computer Aided 

Manufacturing) system. Thus CAD and CAM are interrelated to each other.  

Advantages of CAD 

q Reduction of drafting labor. 

q Direct cost savings. 

q High accuracy (up to one millionth of a unit) 

q Improvement in the general flow of information through the company. 

q Evaluation of alternative designs. 

q Use of common parts in multiple products. 

 

Before we design and manufacture any component, the object must be presented 

in the form of drawings along with different views and dimensions. Further, the bill of 

materials etc. must also be supplied. With the advent of computers and relevant 

software packages, the drafting drifted from manual to computer aided drafting. The 

networking between the shop floor sections and design sections makes it easier to 

share the data and information. The modifications (in the drawings, materials or 

process of operation) if required, can be discussed on line and can be implemented 

without any time lag. An attempt is made here to introduce the graphics package in 

the following topics. 
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 CAD LAB EXPERIMENTS  
1. INITIATING THE GRAPHICS PACKAGE 

 
Aim: Setting the paper size, space; setting the limits, units; use of snap and grid 

commands. 

Requirements: Auto CAD software, PC with a min. of 256MB RAM. 

Description:  

LIMITS: sets and controls the drawing boundaries and grid display. 

 The drawing limits are two-dimensional points in the World Co-ordinate System 

that represent a lower-left limit and an upper-right limit. Limits cannot be imposed on 

the Z direction. 

 Turn on the drawing limits and restrict within the rectangular area. Drawing 

limits also determine the area of the drawing that can be displayed with or without 

grid dots.  

Command: LIMITS 

ON/ OFF/ Lower left corner < current> : 

q On: Turns on limits checking. When the “limits checking” is on, AutoCAD 

rejects attempts to enter points outside the drawing limits.  

q Off: Turns off limits checking, but maintains the current values, for the next time 

when the “limits checking” is turned on. 

 
Procedure: Enter the command “LIMITS”. 

Reset model space limits.  

Specify lower left corner or [ON/OFF], < 0.0000, 0.0000 > : 0,0 (return) 

Specify upper right corner < 120.0000, 120.0000 > : 120,120 ( or any value) (return) 

Command: zoom (return) 

 

Use of Snap And Grid Commands 

GRID displays a dot grid  

At the command prompt, enter ‘GRID’. 

Command: GRID 

Grid Spacing ( X ) or ON / OFF / Snap / Aspect / Current > : 

You can turn grid on and off with F7 key or by double clicking the GRID button in 

the status bar. 
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SNAP restricts cursor movement to specified intervals 

At the command prompt, enter ‘SNAP’. 

 The points you enter with a pointing device can be locked into alignment by 

SNAP. You can rotate the SNAP grid, set differing X and Y spacing, or choose an 

isometric format for the snap grid. 

 A change in the snap grid affects only the co-ordinate of new points. Objects 

already in the drawing retain their existing co-ordinates. 

The snap grid is invisible. Use SNAP with GRID to display a separate visible grid of 

dots. Set the spacing of two grids to equal or related values dots.  

 Command: SNAP 

Snap spacing or ON / OFF / Aspect / Rotate / Style < Current > : 

q Snap spacing: Actives snap mode using the current snap grid resolution, rotation 

and style. 

q ON: Actives snap mode using the current snap grid resolution, rotation and style.  

q OFF: Deactivates snap mode but retains the values and modes. 

q Rotate: Sets the rotation of the snap grid with respect to the drawing and the 

display screen. Any angle between –90 and + 90 can be specified. A positive 

angle rotates the grid counterclockwise about the base point. 

Base point <current > :  

Rotation angle < current >:  

q Style: Selects the format of the snap grid, which is standard or Isometric. Standard 

displays a rectangular grid that is parallel to the XY plane of the current UCS. X 

and Y spacing may differ  

q Spacing: Changes overall spacing. 

q Aspect: Changes the horizontal and vertical spacing individually. 

Isometric displays an isometric grid where the grid points are initially at 30 and 

150-degree angles. 

Vertical spacing < current >: 
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2.  DRAWING OF PRIMITIVES 
 

Aim: Drawing various graphics primitives. 
Requirements: Auto CAD software, PC with a min. of 256MB RAM. 

Description: The command “LINE” creates straight line segments. From the draw 

menu, select Line. At the command prompt, enter Line or L. Line command allows 

creating a line where the end points are specified in two-dimensional or three-

dimensional coordinates. 

 

Procedure:  

Command: limits (return) 

Reset model space limits: 

Specify lower left corner or [ON/OFF], < 0.0000, 0.0000 > : 0,0 (return) 

Specify upper right corner < 120.0000, 120.0000 > : 120,120 ( or any value) 

(return) 

Command: zoom (return) 

Command: line (return) 

Specify first (point P1): 50,50 (return) 

Specify next point (P2): 100,100 (return) 

 

AutoCAD prompts for points, allowing to draw continuous line segments. 

U (Undoing a line) 

This allows erasing the most recent segment in a line sequence 

C (closing a line sequence) 

This allows closing a sequence of continuous line segments, resulting in a 

polygon. 

You may specify the points randomly with the mouse or by any of the 

coordinate systems. 

 

 

 

 

 
P1

P2
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Lines can be drawn, using absolute mode (eg.100,100) or incremental mode 

(eg.@100,100) or polar mode(eg.100<90). 

 

Circle 

The command “CIRCLE” creates a circle. 

From Draw menu, select Circle. 

At the command prompt enter CIRCLE OR C. 

Specify center point for circle: 50,50 (return) 

Specify radius of circle [or diameter]: 50 (return) 

The other options for drawing a circle are 2P, 3P and TTR.  

With 2P option, the user defines two points. These two points are at the diameter of 

the circle. 3P option allows you to define 3 non-collinear points. The circle fits in 

these three points. TTR option allows drawing a circle by defining two tangent points 

and specifying a radius. AutoCAD by default asks for a centre point and radius. 

 

 
 

 

 

 

  



SIR C.R.REDDY COLLEGE OF ENGINEERING 

DEPARTMENT OF MECHANICAL ENGINEERING 7 

ARC 

ARC allows to create an arc segment 

From Draw menu, select Arc 

At the command prompt, enter ARC or A 

Command: ARC 

Center / < start point >: specify a point P1 

Start point - This specifies the start point of an arc 

Center / End/ < second point>: 

Specify a point P2 

Second point - This draws an arc using three specific points along the circumference 

of the arc. The first and the third points from the end points of the arc. The second 

point can be any point on the circumference of the arc. 

 

RECTANG 

RECTANG draws a rectangular polyline 

First corner : specify a point P1 

Other corner : specify a point P2 

P1

P2

P3

P1

P2
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POLYGON 

POLYGON allows you to create polygons with 3 to 1024 numbers of sides.   

From Draw menu, select Polygon 

At the command prompt, enter POLYGON or POL 

Command: POLYGON 

Number of sides < current> 

Edge /< centre of polygon >: 

Number of sides  

This specifies the number of sides the polygon must have. AutoCAD accepts any 

value between 3 to 1024 

Centre of polygon  

Defines the center point of the polygon. Specify a point 

 

Inscribed in circle / Circumscribed about circle ( I/C) < I > : 

Inscribed in circle 

This specifies the radius of a circle on which all vertices of 

the polygon lie. 

 

Circumscribed about circle 

This specifies the distance from the centre of polygon to the 

midpoints of the edges of the polygon. 

Radius of circle: 

Edge  

Defines a polygon by specifying the endpoints of the first 

edge. 

First endpoint of edge 

Second endpoint on edge 

 

 

 

 

Radius

Radius

Edge
P2P1
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ELLIPSE 

 

ELLIPSE  creates an ellipse or an elliptical arc 

From Draw menu, select Ellipse 

At the command prompt, enter Ellipse or EI 

Command: ELLIPSE 

Arc/ center/ <Axis endpoint 1 > :  

Axis endpoint 1: 

This is the first step towards defining the first axis. The two end points of the axis are 

specified. When the first point is specified in the above option, it prompts for the 

second point. 

Axis endpoint 2 :  

< other axis distance > / Rotation : 

The first axis can define either the major or the minor axis of the ellipse. 

Other axis distance 

Defines the second axis as the distance from the centre of ellipse in a direction 

perpendicular to the first axis. 

P1 P2

P3

Ellipse by axis end points

P1 P2

P3

Ellipse by centre point
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3. FLANGE 
Aim: Drawing a flange 
 

Procedure:  
 
FIRST STEP 

Draw PLINE of required cross section 

PLINE creates two-dimensional poly lines 

A  2D poly line is a connected sequence of a line and arc segments, and is created by 

AutoCAD as a single object using region command.   

 

                                                                                     Object to revolve 

 

SECOND STEP 

REVOLVE the drawn pline about required axis and a specified angle 

Command: Revolve 

REVOLVE creates a solid by revolving a two-dimensional object about an axis. 

Select objects : Use object selection method 

Axis of revolution – Object / X / Y / < Start point axis > : Specify a point or enter an 

option. 

Start point of axis: 

Specifies the first and second point of the axis if revolution.  

Angle of revolution <full circle > : Specify an angle or press Enter 

 

Object Axis 
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THIRD STEP 

Draw a circle on the face of the flange and use the polar array command for making 

number of holes on the face. 

 

ARRAY 

ARRAY creates multiple copies of objects in a pattern. 

From modify menu, select Array. 

At the command prompt, enter ARRAY or AR 

Select objects: select objects by any of the selection methods. 

Rectangular / Polar array ( R/P) < current> : 

Polar array 

This creates an array about a definerd center point 

Center point of array: 

Number point of items: 

Angle to fill ( + = ccw, - = cw ) < 360 > : 

Rotate objects as they are copied ? < Y > : 

Angle between items: 

Rotate objects as they are copied? < Y > : 

       Object arrayed 
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FOURTH STEP 

Extrude all the six components to the required path and distance using EXTRUDE 

command. Then subtract all the components from the flange. You will get a required 

flange as shown below. 

 

 

 

 

 



SIR C.R.REDDY COLLEGE OF ENGINEERING 

DEPARTMENT OF MECHANICAL ENGINEERING 13 

4.  BUSHING ASSEMBLY 

Aim: Drawing a bushing assembly 

Procedure: 

FIRST STEP 

Draw PLINE of required cross section 

PLINE creates two-dimensional polylines 

A  2D polyline is a connected sequence of a line and arc segments, and is created by 

AutoCAD as a single object.   

 

SECOND STEP 

REVOLVE the drawn pline about required axis and a specified angle 

Command: Revolve 
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REVOLVE creates a solid by revolving a two-dimensional object about an axis. 

Select objects: Use object selection method 

Axis of revolution – Object / X / Y / < Start point axis >: Specify a point or enter an 

option. 

Start point of axis: 

Specifies the first and second point of the axis if revolution.  

Angle of revolution <full circle >: Specify an angle or press Enter 

 
 
THIRD STEP 
 
Repeat the same procedure for drawing the bearing  
 
                                   Bush 
                                                                                      

 
 
 
 
 
   Journal Bearing 
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FOURTH STEP 
  
Assemble the bush and bearing  

                                                                               
 
    Bearing and bush 
   assembly 

           
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



SIR C.R.REDDY COLLEGE OF ENGINEERING 

DEPARTMENT OF MECHANICAL ENGINEERING 16 

5.  DIMENSIONING THE DRAWING AND ADDING TEXT 
 

Aim: To dimension the drawing and to add text. 
 
Description: 

DIMLINEAR:  DIMLINEAR creates linear dimensions  

From Dimension menu, select Linear 

At the command prompt, enter DIMLINEAR or DLI 

Command: DIMLINEAR 

First extension line origin or RETURN to select: Specify a point or press Enter for 

automatic extension lines 

 

Point specification 

If you specify a point (P1) for the first extension line, AutoCAD prompts for the 

second extension line origin 

Second extension line origin: specify a point (P2  

Object selection-Automatic extension lines 

If you press enter to select an object, AutoCAD automatically determines the origin 

points of the first and second extension lines. 

If you select a circle, the endpoints of its diameter are used as the origin points. When 

the point used to select the circle is close to the north or south quadrant point, 

P1 P2
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 AutoCAD draws a horizontal dimension. When the point used to select the circle 

is close to the east or west quadrant point, AutoCAD draws a vertical dimension. 

Dimension line location (Text/Angle/Horizontal/Vertical/Rotated): 

Specify a point (P2) or enter an option. 

Text: Allows you to customize the text. 
Angle: Changes the angle of the dimension text. 

Enter text angle: specify an angle 

After you specify the angle, AutoCAD prompts  

Dimension line location (Text/Angle/Horizontal/Vertical/Rotated) 

Horizontal:  Creates horizontal linear dimensions 
 Dimension line location (Text/ Angle): Specify a point or enter an option 

Vertical: Creates vertical dimensions 

 Dimension line location (Text/ Angle): Specify a point or enter an option 

Rotate: Creates rotated linear dimensions  

 Dimension line angle<current>: specify an angle or press enter 

DIMALIGNED 

DIMALIGNED creates an aligned linear dimension 

From dimension menu, select Aligned. 

At the command prompt, enter DIMALIGNED or DAL 

Command: DIMALIGNED 

First extension line origin or RETURN to select: Specify a point for  manual 

extension lines, or press enter for automatic extension lines. 

Object selection for Automatic extension lines Automatically determines the origin 

points of the first and second extension lines. 

Select object to dimension: Select an object 
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DIMRADIUS 

DIMRADIUS Creates radial dimensions for circles and arcs 

From Dimension menu, select Radius 

At the command prompt, enter DIMRADIUS or DRA 

Command: DIMRADIUS 

Select arc or circle: select an arc or a circle 

AutoCAD measures the radius and displays the text with the letter R in the front of it 

Dimension line location (Text/ Angle): specify a point or enter an option 

Text 

Dimension text < measured value>: Enter text or press 

Angle 

Enter text angle: specify an angle 

 
 

DIMDIAMETER 

DIMDIAMETER creates diameter dimensions for circles and arcs 

From Dimension menu, select Diameter 

At the command: prompt, enter DIMDIAMETER or DDI 

Command: DIMDIAMETER 

Select arc or circle: select an arc or circle 

AutoCAD measures the diameter and displays the text with symbol in front of it. The 

next prompt is  
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Dimension line location (Text/ Angle): specify a point or enter an option 

Text 

Dimension text < measured value>: Enter text or press return 

Dimension line location: 

Angle 

Changes the angle of the dimension text 

Enter text angle: specify an angle 

After you specify the angle, AutoCAD redisplays  

Dimension line location (Text/ Angle): 

 

DIMANGULAR  

DIMANGULAR creates angular dimensions.  

From dimension menu, select Angular 

At the command prompt, enter DIMANGULAR or DAN 

Command: DIMANGULAR 

Select arc, circle, line or RETURN 

Select the appropriate object or press enter to specify three points 

Three point specification 

Angle vertex: Specify a point (P1) 

First angle end point: specify a point (P2) 

Second angle end point: specify a point (P3) 

Different methods of diameter dimensioning

P1 P2

P3
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Arc selection 

If you select an arc, AutoCAD determines the defining points for a three-point angular 

dimension. The center of the arc is the angle vertex. The arc endpoints become the 

origin points of the extension lines. 

Circle selection 

If you select a circle, the centre of the circle is the angle vertex. The selection point is 

used as the origin of the first extension line 

AutoCAD draws the dimension line as an arc between the extension lines. The 

extension lines are drawn from the angle endpoints to the intersection of the 

dimension line. 

DIMBASELINE 

DIMBASELINE creates a linear, angular, or ordinate dimension from the baseline of 

the previous or selected dimension 

From the Dimension menu, select Baseline or DBA 

Command: DIMBASELINE 

Second extension line origin or RETURN to select: specify a point or press to select a 

base dimension 

P2

P2
P1

P2P1
P1

Angular dimension on arc and circle
 

If the previous dimension was linear, angular or ordinate, AutoCAD uses the first 

extension line origin of that dimension for the first extension line origin of the 

baseline dimension. After you specify a point, AutoCAD draws the baseline 

dimension and redisplays the prompt. 

 

Second extension line origin 

If the previous dimension was linear, angular or ordinate, if you press enter at the 

second extension line origin prompt, AutoCAD prompts you to select linear, angular 

or ordinate dimension to use as the basis for the baseline dimension. 
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Select base dimension: Select a linear, angular or ordinate dimension 

 

DIMCONTINUE 
DIMCONTINUE continues a linear, angular or ordinate dimension from the second 

extension line of the previous or a selected dimension. 

From Dimension menu, select Continue 

At the command: prompt enter DIMCONTINUE or DCO 

Command: DIMCONTINUE 

If the previous dimension was linear, angular or ordinate, AutoCAD uses the origin of 

that dimensions second extension line for the origin of the next dimension’s first 

extension line. 

Select extension line origin or RETURN to select: 

Specify a point or press enter to select a continued dimension 

After you specify a point, AutoCAD draws the next dimension. AutoCAD redisplays 

the prompt 

Select extension line origin or RETURN to select: 

To end the command, press enter 

Linear baseline dimensioning

Selected base dimension

Selected base dimension

Second extension line origin
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DIMORDINATE 

DIMORDINATE crates ordinate point dimensions  

From Dimension menu, select Ordinate. 

At the Command prompt, enter DIMORDINATE or DOR 

Ordinate dimensions display the X or Y coordinate of a feature along with a simple 

leader line. These dimensions are also known as datum dimensions. AutoCAD uses 

the current UCS to determine the measurement. 

Command: DIMORDINATE 

Select feature: specify a point or snap to an object 

Leader endpoint (X datum /Y datum /Text): Specify a point or enter an option 

 

 

 

Linear continuous dimensioning

Second extension line origin

Ordinate dimensioning
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TEXT OBJECT  

Description: 

You can use TEXT to enter several lines of text that you can rotate, justify, and resize. 

As you type at the Enter Text prompt, the text you are typing is displayed on the 

screen. Each line of text is a separate object. To end a line and begin another, press 

ENTER after entering characters at the Enter Text prompt. To end TEXT, press 

ENTER without entering any characters at the Enter Text prompt.  

By applying a style to the text, you can use a variety of character patterns or fonts that 

you can stretch, compress, make oblique, mirror, or align in a vertical column. 

 
Procedure: 

Draw menu: Text Single Line Text 
Command line: text  
Current text style: current  

Current text height: current  

Specify start point of text or [Justify/Style]: Specify a point or enter an option  

If TEXT was the last command entered, pressing ENTER at the Specify Start Point of 

Text prompt skips the prompts for height and rotation angle and immediately displays 

the Enter Text prompt. The text is placed directly beneath the previous line of text. 

The point specified at the prompt is also stored as the insertion point of the text.  

 

START POINT 

Specifies a start point for the text object.  

Specify height <current>: Specify a point (1), enter a value, or press ENTER  

The Specify Height prompt is displayed only if the current text style does not have a 

fixed height.  

Specify rotation angle of text <current>: Specify an angle or press ENTER  

Enter text: Enter text and press ENTER to exit the command  

 

JUSTIFY 

Controls justification of the text.  

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]:  

You can also enter any of these options at the Specify Start Point of Text prompt.  
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Align  

Specifies both text height and text orientation by designating the endpoints of the 

baseline.  

Specify first endpoint of text baseline: Specify a point (1)  

Specify second endpoint of text baseline: Specify a point (2)  

Enter text: Enter text and press ENTER to exit the command  

The size of the characters adjusts in proportion to their height. The longer the text 

string, the shorter the characters.  

  

Fit  

Specifies the text that fits within an area and at an orientation defined with two points 

and a height. Available for horizontally oriented text only.  

Specify first endpoint of text baseline: Specify a point (1)  

Specify second endpoint of text baseline: Specify a point (2)  

Specify height <current>:  

Enter text: Enter text and press ENTER to exit the command  

The height is the distance in drawing units that the uppercase letters extend from the 

baseline. Designated text height is the distance between the start point and a point you 

specify. The longer the text string, the narrower the characters. The height of the 

characters remains constant.  

 
Center  
Aligns text from the horizontal center of the baseline, which you specify with a point.  

Specify center point of text: Specify a point (1)  

Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

The rotation angle specifies the orientation of the text baseline with respect to the 

center point. You can designate the angle by specifying a point. The text baseline runs 

from the start point toward the specified point. If you specify a point to the left of the 

center point, AutoCAD draws the text upside down.  
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Middle  
 

Aligns text at the horizontal center of the baseline and the vertical center of the 

height you specify. Middle-aligned text does not rest on the baseline.  

Specify middle point of text: Specify a point (1)  

Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

The Middle option differs from the MC option in that it uses the midpoint of all text, 

including descenders. The MC option uses the midpoint of the height of uppercase 

letters.  

 

Right  
 
Right-justifies the text at the baseline, which you specify with a point.  

Specify right endpoint of text baseline: Specify a point (1)  

Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

 

TL (Top Left)  

Left-justifies text at a point specified for the top of the text. Available for horizontally 

oriented text only.  

Specify top-left point of text: Specify a point (1)  

Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

 

TC (Top Center)  

Centers text at a point specified for the top of the text. Available for horizontally 

oriented text only.  

Specify top-center point of text: Specify a point (1)  

Specify height <current>:  
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Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

 

TR (Top Right)  

Right-justifies text at a point specified for the top of the text. Available for 

horizontally oriented text only.  

Specify top-right point of text: Specify a point (1)  

Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

 

ML (Middle Left)  

Left-justifies text at a point specified for the middle of the text. Available for 

horizontally oriented text only.  

Specify middle-left point of text: Specify a point (1)  

Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

 

MC (Middle Center)  

Centers the text both horizontally and vertically at the middle of the text. Available 

for horizontally oriented text only.  

Specify middle-center point of text: Specify a point (1)  

Specify height of text <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

The MC option differs from the Middle option in that it uses the midpoint of the 

height of uppercase letters. The Middle option uses the midpoint of all text, including 

descenders.  

MR (Middle Right)  

Right-justifies text at a point specified for the middle of the text. Available for 

horizontally oriented text only.  

Specify middle-right point of text: Specify a point (1)  
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Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

 

BL (Bottom Left)  

Left-justifies text at a point specified for the baseline. Available for horizontally 

oriented text only.  

Specify bottom-left point of text: Specify a point (1)  

Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

 

BC (Bottom Center)  

Centers text at a point specified for the baseline. Available for horizontally oriented 

text only.  

Specify bottom-center point of text: Specify a point (1)  

Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  

 

BR (Bottom Right)  

Right-justifies text at a point specified for the baseline. Available for horizontally 

oriented text only.  

Specify bottom-right point of text: Specify a point (1)  

Specify height <current>:  

Specify rotation angle of text <current>:  

Enter text: Enter text and press ENTER to exit the command  
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6. SETTING THE LAYERS AND APPLICATION OF LAYERS 
 

Aim: To set the layers and to learn and manage the layers. 
 
Description:  
 
LAYER: The command “LAYER” manages layers. It makes a layer current, adds 

new layers, deletes layers and renames layers. One can assign properties to layers, 

turn layers on and off, freeze and thaw layers globally or by view port, lock and 

unlock layers, set plot styles for layers, and turn plotting on and off for layers. Also, 

one can filter the layer names displayed in the Layer Properties Manager, and can 

save and restore layer states and properties settings.  

By creating layers, one can associate similar types of objects by assigning them to 

the same layer. For example, construction lines, text, dimensions, and title blocks can 

be put on separate layers and can then be controlled to check 

• Whether the objects on a layer are visible in any view ports  

• Whether and how the objects are plotted  

• What color is assigned to all the objects on a layer  

• What default line type and line weight is assigned to all objects on a layer  

• Whether objects on a layer can be modified 

When a new drawing is begun, AutoCAD creates a special layer named 0. By default, 

layer 0 is assigned colour number 7 (white or black depending upon your background 

colour), the CONTINUOUS line type, a line weight of Default (the default setting is 

.01 inch or .25 mm), and the NORMAL plot style. Layer 0 cannot be deleted or 

renamed.  

 

Procedure: 

From Format menu, select Layer 

At the command prompt, enter LAYER or LA 

The Layer & Line type properties dialog box appears 

Command: LAYER  

Various icons and buttons in the dialog box indicate various statuses of layers and 

layer management tools.  
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Named Layer Filters  

Determines which layers to display in the list of layers. You can filter layers based on 

whether they're xref-dependent, or whether they contain objects. You can also filter 

layers based on name, visibility, color, line type, line weight, plot style name, whether 

they are plotted, or whether they are frozen in the current view port or in new view 

ports.  

 

[...] Button: Displays the Named layer filters dialog box  

 

Invert Filter: Displays layers based on the opposites of the criteria in a named layer 

filter. Layers that fit the inverse criteria are displayed in the layer name list.  

 

New  

Creates a new layer. After you choose New, the list displays a layer named LAYER1. 

You can edit this layer immediately. To create multiple layers more quickly, you can 

select a layer name for editing and enter multiple layer names separated by commas.  

If you create a new layer, the new layer inherits the properties of the currently 

selected layer in the layer list (Color, On/Off state, and so on). To create layers with 

default settings, make sure that there are no selected layers in the list or that you select 

a layer with default settings before beginning layer creation.  

Current  

Sets the selected layer as the current layer  

Delete  

Deletes selected layers from the drawing file definition. You can delete only 

unreferenced layers. Referenced layers include layers 0 and DEFPOINTS, layers 

containing objects, the current layer, and xref-dependent layers. Layers that don't 

contain objects, are not current, and are not xref-dependent can be deleted. 

List of Layers: Displays layers and their properties. To modify a property, click its 

icon. To quickly select all the layers, use the right-click and shortcut menu.  

Names: Displays the names of the layers. You can select a name, and then click and 

enter a new name.  

On/Off: Turns layers on and off. When a layer is on, it is visible and available for 

plotting. When a layer is off, it is invisible and not plotted, even if Plot is on.  
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Freeze/ Thaw selected layers in all view ports.  

You can freeze layers to speed up ZOOM, PAN, and many other operations; 

improve object selection performance; and reduce regeneration time for complex 

drawings. AutoCAD does not display, plot, hide, render, or regenerate objects on 

frozen layers.  When you thaw a frozen layer, AutoCAD regenerates and displays the 

objects on that layer. You can freeze layers in all view ports, in the current layout 

view port, or in new layout view ports as they are created.  

Lock/Unlock: Locks and unlocks the layers. You cannot edit objects on a locked 

layer. Locking a layer is useful if you want to view information on a layer for 

reference but do not want to edit objects on that layer.  

Color: Changes the color associated with the selected layers. Clicking the color name 

displays the select color dialog box.  

Linetype: Changes the line type associated with the selected layers. Clicking any line 

type name displays the select Line type color dialog box.  

 Lineweight: Changes the line weight associated with the selected layers. Clicking 

any line weight name displays the select Line weight color dialog box.  

Plot Style: Changes the plot style associated with the selected layers. If you are 

working with color-dependent plot styles you cannot change the plot style associated 

with a layer. Clicking any plot style displays the select plot style dialog box.  
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7. ISOMETRIC AND ORTHOGRAPHIC PROJECTIONS 

Aim: To create isometric and orthographic projections of a drawing. 

Procedure:  

3DFACE 

3DFACE creates a three dimensional face 

From Draw menu, select Surfaces 

At the command prompt, enter 3DFACE or 3F 

First point: Specify a point (P1) 

Second point: Specify a point (P2) 

Third point: Specify a point (P3) 

Fourth point: Specify a point (P4) or press Enter 

AutoCAD repeats the Third point and fourth point prompts until you press Enter. 

Specify points 5 and 6 at these repeating prompts. When you have finished entering 

points, press Enter. 

 

Description:  

HIDE 

HIDE regenerates a three-dimensional model with hidden lines suppressed. 

From View menu, select Hide 

Procedure: At the command prompt, enter HIDE or HI 

 

Description:  

VPORTS: VPORTS divides the graphics area into multiple tiled view ports 

Command: VPORTS 

Procedure for orthographic projection: 

Save /Restore/ Delete/ Join /Single/? / 2/ 3/ 4/: Enter an option or press Enter 3. 

This option divides the current view port into three view ports. 

Horizontal/ Vertical/ Above/ Below /Left / < Right>:  

Enter an option or press Enter 

The horizontal and vertical options split the area into thirds. The other options create 

one large view port of half the available area and two smaller ones. The Above, 

Below, Left, and Right options specify where the larger view port is placed. 

The option “2” divides the current view port in half. 
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Horizontal< Vertical>: Enter h or press Enter 4. 

This option divides the current view port into four view ports of equal size. 

Single: Returns the drawing to a single view port view, using the view from the active 

view port. 

Join 

Combines two adjacent view ports into one larger view port. The resulting view port 

inherits the view of the dominant view port. 

Select dominant view port < current>: Press Enter or select a View port 

Select view port to join:  

Save 

Saves the current view port configuration using a specified name. 

? / Name for new view port configuration: Enter a name or? 

Entering? Lists the saved view port configurations. 

Restore 

Restores a previously used view port configuration. 

? / Name of view port configuration to restore: Enter a name or ? 

Delete 

? / Name of view port configuration to delete: Enter a name or ? 

 

REVSURF 

REVSURF creates a revolved surface about a selected axis. 

From Draw menu, select Surfaces > Revolved Surfaces 

At the command: prompt, enter REVSURF 

REVSURF constructs a polygon mesh approximating a surface of revolution by 

rotating a path or profile about a selected axis. 

Command: REVSURF 

Select path curve: Select a line, circle, or 2D or 3D polyline 

Select axis of revolution: Select a line or open 2D or 3D polyline 

The path curve is swept about the selected axis to define a surface. 

Start angle < 0 >: Enter a value or press Enter 

Included angle (+ = ccw, - = cw) < Full circle> : Enter a value or press Enter 
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3D 

3D creates three-dimensional polygon mesh objects 
 
From Draw menu, select Surfaces > 3D surfaces 

At the command prompt, enter 3D. 

The three-dimensional polygon mesh objects 3D constructs look like wire frame 

objects but have surfaces. Thus, 3D objects can be shaded or rendered to appear as 

solid objects. 

Command: 3D 

Selecting 3D objects from the menu displays the 3D dialog box. . Entering 3D on the 

command line displays the following prompt:  

Box / Cone / Dish/ Mesh/ Pyramid / Sphere / Torus / Wedge: Enter an option 

 

Box : Creates a 3D box polygon mesh. 

Corner of Box: Specify a point 

Length: Specify a distance 

Cube / <Width >: Specify a distance or Enter C 

Width: Defines the width of the box 

Height: specify a distance 

Rotation angle about Z axis: Specify an angle 

The base point for the rotation is the first corner of the box. 

 

Cube 

Creates a cube using the length for the width and height of the box 

Rotation angle about Z axis: Specify  an angle 

The base point for the rotation is the first corner of the box 
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Cone 

Creates a cone –shaped polygon mesh. 

Base center point: Specify a point 

Diameter < radius > of base: Specify a distance or Enter D 

 

Sphere 

Command: Sphere 

Centre of sphere <0,0,0>: Specify a point or press Enter 

Diameter / <Radius > of sphere: Specify a distance or enter d 

 

Torus 

Torus creates a donut shaped solid 

At the command prompt, enter TORUS or TOR 

A torus is defined by two radius values, one for the tube and the other from the centre 

of the torus to the centre of the tube. 

Command: TORUS 

Center of torus <0,0,0 >: Specify a point or press Enter 

Diameter / <Radius > of Torus: Specify a distance or enter d 
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UNION 

UNION creates a composite region or solid by addition 

At the command prompt, enter UNION or UNI 

Command: UNION 

Select objects: Use an object selection method 

Solid Objects selected     Solid Objects United 

 

SUBTRACT 

 

SUBTRACT creates a composite region or solid by subtraction 

At the command: Prompt, enter SUBTRACT or SU 

Command: SUBTRACT 

Select objects: Use an object selection method 

Select objects: Press Enter  

Select solids and regions to subtract 

Select object: Use an object selection method. 

Select object: press Enter 

 

 

Solid object Selected Solid object subtracted 
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INTERSECT 

 

INTERSECT creates composite solids or regions from the intersection of two or more 

solids or regions 

At the command prompt, enter INTERSECT or INT 

Command: INTERSECT 

Select objects: Use an object selection method 

 

       Two Cylinders  Intersected part 

 

Procedure for drawing Isometric Views: 

1. Change the cursor position to an Isometric plane. 

2. From the tool menu, choose drafting settings. 

3. In the drafting setting dialogue box, put ON the Snap & Grid tab under snap 

type and style, and select Isometric snap. 

4. Choose O.K. 

5. Cursor is changed to an Isometric plane. 

6. We can cycle through the three Isometric planes by pressing F5. 

7. AutoCAD through the Iso-plane top, Iso-plane right and Iso-plane left. 
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8. VIEWING IN THREE DIMENSIONS 

 

Aim: To view the drawings in three dimensions. 

Description:  VPOINT 

VPOINT sets the viewing direction for a three dimensional visualization of the 

drawing. 

Procedure: 

From menu, select 3D Viewpoint  

At the command prompt, enter VPOINT. 

Command: VPOINT 

Rotate / < View point > < Current>: Enter R, specify a point , or press to display a 

compass and axis tripod. 

Viewpoint 

AutoCAD follows some convention regarding the sides of a model. As shown in the 

figure assuming you are standing on top of the model facing along the +ve Y 

direction, the following directions are defined. 

 

 

+ ve X   : Right side 

- ve X   : left side 

+ ve Y   : Back side 

- ve Y   : Front side 

+ ve Z   : Top side 

-ve Z   : Bottom side 

According to this rule, if you want to see the front side of the model, you need to walk 

along – ve Y-axis. Based on this rule, you can derive the VPOINT.  

Left

Back

Right

Front
Top

bottom

X

Y
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V Point Value View 

0, 0, 1 Top View 

0, 0, -1 Bottom View 

0, -1, 0 Front View 

0, 1, 0 Back View 

1,0, 0, Right View 

-1, 0, 0 Left View 

1,-1, -1 Right, front ,Bottom View 

-1,-1, -1 Left, front, Bottom View 

1,1, -1 Right, Back, Bottom View 

-1,1, -1 Left, Back, Bottom View 

1,-1, 1 Right, Front, Top View 

-1,-1, 1 Left, Front, Top View 

1,1, 1 Right, Back, Top View 

-1,1, 1 Left, Back, Top View 

 

Compass & Tripod 

Pressing enter displays a compass and axis tripod, which you use to define a viewing 

direction in the view port . 

To select a viewing direction, move the pointing device to a location on the globe and 

press the pick button. 

With reference to the compass, the resulted view depends on the where you select the 

view point on the compass. 

 

 

 

Bottom Top

Back

Front

Left Right



SIR C.R.REDDY COLLEGE OF ENGINEERING 

DEPARTMENT OF MECHANICAL ENGINEERING 39 

• Any where to the right of the vertical line gives Right side view. 

• Any where to the left of the vertical line gives left side view 

• Any where above the horizontal line gives Backside view 

• Any where below the horizontal line gives Front side view 

• Any where inside the small circle gives Top view 

• Any where in between small and large circles gives Bottom view 
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9. REMOVAL OF HIDDEN LINES - SHADING AND RENDERING  
 
Aim: To remove the hidden lines. To apply shading on the model and also to render 
the model. 
Description: 

Controls the display of object shading in the current view port . 

View menu: Shade 

Command line: shademode  

Enter option [2D wireframe/3D wireframe/Hidden/Flat/Gouraud/fLat+edges/ 

Gouraud +edges] <current>: Enter an option 

 
 

2D Wireframe 

Displays the objects using lines and curves to represent the boundaries. Raster and 
OLE objects, linetypes, and lineweights are visible. Even if the value for the 
COMPASS system variable is set to 1, it does not appear in the 2D Wireframe view.  

3D Wireframe 

Displays the objects using lines and curves to represent the 
boundaries. Displays a shaded 3D UCS icon. Raster and OLE 
objects, linetypes, and lineweights are not visible. You can set the 
COMPASS system variable to 1 to view the compass. Material 
colors that you have applied to the objects are shown 

Hidden 

Displays the objects using 3D wireframe representation and hides 
lines representing back faces.  

Flat Shaded 

Shades the objects between the polygon faces. The objects appear 
flatter and less smooth than Gouraud-shaded objects. Materials that 
you have applied to the objects show when the objects are flat 
shaded.  
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Gouraud Shaded 

Shades the objects and smooths the edges between polygon faces. 
This gives the objects a smooth, realistic appearance. Materials that 
you have applied to the objects show when the objects are Gouraud 
shaded.  

Flat Shaded, Edges On 

Combines the Flat Shaded and Wireframe options. The objects are 
flat shaded with the wireframe showing through.  

Gouraud Shaded, Edges On 

Combines the Gouraud Shaded and Wireframe options. The objects 
are Gouraud shaded with the wireframe showing through.  

 
Procedure for Removal of hidden lines: 
 

1. On the view menu choose “hide” or enter the command “hide” or “hi”. 
2. The lines remain hidden until you perform an action that regenerates the 

drawing and redisplays a hidden line wire frame view. 
 
Procedure for Shading: 

1. Enter the command “Shade” or from the view menu choose “shade” 

2. Choose one of the following option, .e. 2D wire frame/ D wireframe/ Hidden/ 

flat shaded/ Gouraud shaded/ flat shaded edges on/ Gouraud shaded edges on/. 

3. Select the required option to shade the object. 

 

RENDERING 

View menu: Render Render 
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Command line: render  

Defines the scene, procedure, options, destination, sampling, and other settings for 

rendering.  

Rendering Type  

Lists Render, Photo Real, Photo Raytrace.  

Scene to Render  

Lists scenes, including the current view that you can select for rendering.  

Rendering Procedure  

Controls how RENDER behaves by default.  

Query for Selections  

Displays a prompt to select objects to render.  

Crop Window  

Creates a render area at render time. When you choose Render, AutoCAD prompts 

you to select an area on the screen before rendering proceeds. This option is available 

only when View port is selected under Destination.  

Skip Render Dialog  

   
 

 

 

 
 
 

 

 

 

 

 

 

 

 

 

 

 



SIR C.R.REDDY COLLEGE OF ENGINEERING 

DEPARTMENT OF MECHANICAL ENGINEERING 43 

Procedure for Rendering: 

1. To the solid object apply the material using RMAT command. 

2. To see that the particular applied material, we have to use “render”. 

3. Enter the command render or RR. 

4. Select the Current view.  

5. Choose O.K. 

6. Rendering command can also be applied for back ground and images of the 

object. 

 

CAD VIVA QUESTIONS 
 

1. What are the uses of Grid and Snap commands? 
2. Write different coordinate systems and write the syntax for those coordinate 

systems? 
3. Write diff. draw commands used for tutorial -1? 
4. Write about ‘p line’ command and write the modifying command which is 

used to modify ‘p line’. 
5. How many modes are there to draw an arc? name them. 
6. Write diff modes to draw a circle. 
7. Write the use of array command and name diff. types of array commands. 
8. Write the difference between extend and trim commands. 
9. How many times REDO command works at a time? 
10. What is the use of B HATCH command? 
11. Write the command which is used to dimension and object. 
12. What is the difference between TEXT and M TEXT command? 
13. What is the use of layers? 
14. Write different layer properties and layer states**** and explain them. 
15. Write the procedure to highlight a layer. 
16. How to create a layer? 
17. What is the use of Freeze? 
18. How to create an isometric grid and oblique? 
19. What is the diff. between Orthographic, Isometric and Projection? 
20. What keys are used to select the isoplanes cursor? 
21. Write different 3D geometric models used in Auto CAD? 
22. What is the use of Extrude command? 
23. What is the use of Revolve command? 
24. Write diff. modifying commands used in solid modelling. 
25. What do you mean by V Port? What is the use of it? 
26. Write the difference between sweep and Extension command. 
27. What is meant by B-rep? 
28. What are the different display controls used? 
29. What are diff. Graphic standards? 
30. What is the use of limits command? 
31. Write diff. editing commands? 
32. What are the diff. selection methods? 
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33. What is the diff. between copy and mirror commands? 
34. Explain about ‘explode’ command? 
35. Explain about ‘block’ command. What are the uses and how to create it? 
36. Explain about ‘W block’ command? 
37. What is the one of DDedit command? 
38. Write about X ref. Command. What is the diff. between insert and X ref. 

commands? 
39. Write about Purge command. 
40. Write about Donut command. 
41. What do you mean by Aperture and pick box? 
42. What is the diff. between Annotation and Attributes? 
43. Write about Grip, ddgrip, grip color, grip hot. 
44. What are the diff. extensions used for a file? 
45. Write differences between copy and copy clip commands. 
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CAM LAB EXPERIMENTS  
 

1.  PREPARATION OF MANUAL PART PROGRAMMING FOR 
CNC TURNING/MILLING 

 
MANUAL PART PROGRAMMING FOR CNC LATHE  
 
Program in incremental mode  

Tool Offset T1 X-0.3 Z 0 

G92  X0  Z0 

N1 G01  X-13  F80  T1 

N2  Z-4 

N3  X4  Z-5 

N4  Z-5  

N5  X-2  Z-2 

N6  Z-10  

N7  X10  Z-5 

N8  Z-3 

N9  X-2  Z-2 

N10  X2  Z-2 

N11  Z-6  

N12  G0  X1 

N13  Z44  T0 

N14  M30 

 
 
 
EXAMPLE 1: MILLING 
 
[ BILLET L 170 W 90 D 10 
[ EDGEMOVE X-70 Y-30 
[ TOOLDEF T1 L 65 D6 
[ SET DATUM X 20 Y20  
N1 G00X0Y-18.4 Z5 
N2 MO3 S1000 
N3 G01 Z-3  
N4 GO1 X32  
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N5 GO3 X32 Y18.4 R18.4 
N6 GO1 X18.4 
N7 GO1 X18.4 Y32 
N8 GO3 X-18.4 R18.4 
N9 GO1 Y0 
N10 GO3 X0 Y-18.4 R18.4 
N11 GO0 X0 Y0 Z5 
N12 M05 
 
 
EXAMPLE 2: MILLING      
 
[ BILLET L 170 W 90 D 10 
[ EDGEMOVE X-60 Y-55 
[ TOOLDEF T1 L 65 D6 
[ SET DATUM X 60 Y45  
N1 G00X-30Y-43 Z5 
N2 MO3 S1000 
N3 G01 Z-3  
N4 GO1 X30  
N5 GO3 X41.21Y-26.51 R13 
N6 GO1 X14.78 Y11.98 
N7 GO3 X-14.782 Y11.98 R18 
N8 GO3 X-40.25 Y-26.51 
N9 GO3 X-30 Y-43 R13 
N10 GO0 X0 Y0 Z5 
N11  M05 
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2. PART PROGRAMMING PREPARATION THROUGH 
AUTOCAD 

 
 

 

 

 

 

 

 

 

Program in incremental mode  

Tool Offset T1 X-0.3 Z 0 
G92  X0  Z0 
N1 G01  X-11  F100  T1 
N2  Z-1 
N3  X3 Z-3 
N4  Z-7  
N5  G02 X5  Z-5    15    K0 
N6  G01 Z-5  
N7  X-3   Z-5 
N8  Z-34 
N9  G2 X5   Z-5    15     K0 
N10  X2  Z-5 
N11  X-2   Z-2 
N12   X2  Z-2 
N13  Z-2  
N14  G0  X11 
N15 Z 53 
N16 G2  X0 Z-40   10 K –20 
N17 G0  X0 Z 63    T0 
N18  M 30 
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3. APT SYSTEM 
 

APT GEOMETRY : Any part geometry can be built up from the basic geometric 

elements. A few geometric elements are defined below are. 

 

Point definitions in APT 

 

 Syntax: <symbol> = POINT / <parameter listing> 

 

1. POINT defined by rectangular coordinates 

  P1 = POINT / 50, 75, 70 

  P2 = POINT / 50, 25 

2. POINT defined by intersection of two lines 

  P2 = POINT / INTOF, L1, L2 

3. POINT by intersection of a line and a circle 

  POINT/XLARGE 

    XSMALL 

    YLARGE NTOF, line, circle 

    YSMALL 

  P3 = POINT / XSMALL, INTOF, L, C 

4 POINT by intersection of two circles 

  POINT/XLARGE 

    XSMALL 

    YLARGE NTOF, line, circle 

    YSMALL 

  P4 = POINT / 25 

  C1A = CIRCLE / YSMALL, INTOF, C1, C2 

 

 

Line definitions in APT 

 

1. LINE passing through two points 

LINE/ point 1, point 2 

  L1 = LINE / PT1, PT2 
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  LINE/ x1,y1, x2, y2 

  L1B = LINE / 20, 30, 70, 60 

2. LINE passing through a point and parallel to a line 

LINE/point, PARLEL, line 

  L3 = LINE / P3, PARLEL, L1 

3. LINE passing through a point and perpendicular to a line 

LINE/ point, PERTO, line 

  L4 = LINE/P4, PERPTO, L1 

4. LINE passing through a point and tangent to a circle 

  LINE / point   LEFT 

       RIGHT, TANTO, circle 

  L8 = LINE / PT, LEFT, TANTO, CR 

  L8A = LINE / PT, RIGHT, TANTO, CR 

5. LINE tangential to two circles 

  LINE /point  LEFT LEFT 

       RIGHT, TANTO, circle1,  RIGHT, TANTO, circle2 

  L9 = LINE / LEFT, TANTO, C1, RIGHT, TANTO, C2 

  L8A = LINE / RIGHT, TANTO, C1, RIGHT, TANTO, C2 

 
CIRCLE DEFINITIONS IN APT 

 
 Syntax: <symbol> = CIRCLE / <parameter string> 
 
1. CIRCLE defined by its center and radius 

  CIRCLE / x, y, radius 

  CIRCLE / CENTRE, point, RADIUS, radius 

  C1 = CIRCLE / 75, 50, CENTRE, PT1, RADIUS, 45 

2. CIRCLE defined by its centre and tangent to a line 

  CIRCLE / CENTRE, point, TANTO, line 

  C2 = CIRCLE / CENTRE, PT2, TANTO, L1 

3. CIRCLE defined by its centre and a point on the circumference 

  CIRCLE / CENTRE, point1, point2  

  C3 = CIRCLE / CENTRE, P3, PT3 

 

4. CIRCLE passing through three points 
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  CIRCLE / point1, point2, point3 

  C4 = CIRCLE / PT4, PT5, PT6 

 

5. CIRCLE of known radius tangential to two lines 

  CIRCLE  XLARGE 

     XSMALL 

     YLARGE 

     YSMALL, line1, $ 

 

     XLARGE 

     XSMALL 

     YLARGE 

     YSMALL, line2, RADIUS, radius 

  C6 = CIRCLE / YLARGE, L2, YSMALL, L2, RADIUS, 15 

  C6A = CIRCLE / YLARGE, L1, XSMALL, L2, RADIUS, 15 

6. CIRCLE of known radius and tangent to circle 

  CIRCLE  XLARGE 

     XSMALL 

     YLARGE 

     YSMALL, IN 

        OUT, circle1, IN 

            OUT, circle2, RADIUS, radius 

  C8A = CIRCLE / YLARGE, OUT, C1, IN, C2, RADIUS, 15 

  C81 = CIRCLE / YLARGE, IN, C3, OUT, C4, RADIUS, 50 

 

Plane  definitions in APT 

 

 Syntax: <symbol> = PLANE / <parameter string> 

 

1. PLANE passing through three points 

  PLANE / point1, point2, point3 

  PL1 = PLANE / P1, P2, P3 

MOTION COMMANDS 



SIR C.R.REDDY COLLEGE OF ENGINEERING 

DEPARTMENT OF MECHANICAL ENGINEERING 51 

 

They are used to describe the actual machining sequence making use of geometric 

statements defined. The motion commands are divided into 3 groups. 

1. Set up commands. 

2. Point-to-point commands. 

3. Continuous path motion commands. 

 

SET UP COMMANDS: 

  The set up commands are required for initiating the machining operations. 

 

Starting point command: 

 To establish the starting point of the cutter for the starting motion. 

  FROM / POINT 

  FROM / x, y  or FROM / x, y, z 

 

Cutter command: 

 To describe the cutting tool. 

  CUTTER / d  or CUTTER / d, r 

 

Surface commands: 

 The desired path of the 3-dimensional cutting tool is described by means of three 

interesting surfaces. These surfaces are 

  Part surface (PS) 

  Drive surface (DS) 

  Check surface (CS) 

The part surface is the surface which is in continuous contact with the top of the tool.  

Drive surface is the plane along with the cutter is in machining contact. 

CS is the surface which limits the motion of the tool.] 

POINT TO POINT MOTION COMMANDS : 

Position in APT is achieved with two statements GOTO and GODLTA  

GODLTA : incremental  motion : 

       GODLTA / dx, dy, dz   if one value is given with GODLTA, 

       GODLTA /dz    it is implied for Z value. 
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       GODLTA / VECTOR. 

GOTO     :  Absolute movement command  

       GOTO/ point  

     GOTO/ x,y or GOTO/ z,y,x 

When no z value is specified , it takes from ZSURF.  

GOTO can also be used for position ing at PATTERN  

GOTO / pattern  

The type of machining is specified by POST PROCESSOR commands 

preceding GOTO statement.  

 

CONTINUOUS PATH MOTION COMMANDS: 

 

Part surface command: 

Part surface is specified by PSIS 

  PSIS / PL (PL is a plane defined earlier) 

 Part surface can be established. 

 Parallel to X, Y plane at current Z height by AUTO PS. 

 NOPS (is a non-model command). 

To ignore a part surface which is already in force, NOPS is used before Startup 

command and the original part surface is restored after the startup motion. 

 

START UP command: 

Before proceeding to start machining, the cutting tool should bring in contact with the 

part and drive surface within specified tolerance. 

i) 3 surface startup command: 

   TO   TO   TO 
 GO /  ON, ds  ON, ps,   ON, cs 
   PAST  PAST  PAST 
ii) 2 surface startup command: 

   TO   TO    
 GO /  ON, ds  ON, ps,    
   PAST  PAST   
iii) 1 surface startup command: 

   TO    
 GO /  ON, ds    
   PAST  
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If no terminal modifier is specified, the default is TO. The end point of tool is always 

in contact with part surface, so only TO is meaningful with part surface. 

To avoid ambiguity (if any) direction control commands are used. 

 INDIRP / point 

 INDIRV / vector 

 

Tool relationship commands: 

 TLRGT (tool is on right side of drive surface) 

 TLLFT (tool is on left side of drive surface) 

 TLON (tool is on the drive surface) 

Tool relationship should be mentioned before motion commands. 

 

ACTION verbs: 

The direction of every motion of the tool have to be specified with respective to its 

previous motion direction. The following six action verbs are used for this purpose. 

1. GO LFT / Move left along the drive surface. 

2. GO RGT / Move right along the drive surface. 

3. GO FWD / Move forward from a tangent position. 

4. GO BACK / Move backward from tangent position. 

5. GO UP / Move up along the drive surface. 

6. GO DOWN / Move down along the drive surface. 

To describe any motion, one of the above six action verbs are required. 

Action verbs define direction w.r.t. the previous motion.  

 

Example of simple contour: 

 

Check surface is implied when the check surface becomes the drive surface in the 

subsequent command. 
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 GO/L1, PS, L4 
 TLLFT 
 GOLFT/L1, PAST, L2 GOLFT/L1 
 GORGT/L2, PAST, L3 GORGT/L2 
 GORGT/L3, PAST, L4 GORGT/L3 
 GORGT/L4, PAST, L1 GORGT/L4, PAST, L1 
 
 
 
 

 
 

Machining outside     Machining inside  
Contour    contour 
FROM/SP         FROM/SP $$ DOTTED 
GO/L1, PS, L4        GO/PAST, L1, PS1, PAST L4 
TLRGT     TLLFT      
GORGT/L1, PAST, L2 GORGT/L1, L2 
GOLFT/L2, PAST, L3 GOLFT/L2, L3 
GOLFT/L3, PAST, L4 GOLFT/L3, L4 
GOLFT/L4, PAST, L1 GOLFT/L4, L1 

 
 
 

POST PROCESSOR COMMANDS 
 
PARTNO/ is used to indicate the name of the part program. 
    PARTNO/  part details. 
MACHIN/ is used to specify the machine tool. 
    ACHIN/  RILL, 4  to specify the 4th NC drill in the cell. 
COOLNT/ is used to turn coolant ON or OFF. 
    OOLNT/  MIST to turn on the air coolant. 
    OOLNT/  FLOOD to turn on the oil coolant. 
    OOLNT/  OFF  to turn coolant off. 
FEDRAT/ is used to specify the feed rate of cutter motion. 
       PM   f inch per minute 
       MPM   f mm per minute 
    EDRAT/  IPR, f   f inch per revolution 
       MPR   f mm per revolution 
RAPID  is used to indicate the rapid speed (similar to G00). 
SPINDL/ is used to specify the speed of the spindle. 
       SFM   n surface feed feet per minute 
    SPINDL/  RPM, n, CLW  n revolutions per minute 
       SMM CCLW n surface meters per minute 
CUTCOM/ is used for inclusion of cutter compensation. 
       ON 
    CUTCOM/ OFF,  LENGTH, a    a refers the register associated 
       RIGHT RADIUS        with compensation 
       LEFT 

 SP 

L1 L3 

L2 

L4 

 SP 

L1 

L3 

L2 L4 
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CYCLE/  is used to generate canned cycles for drilling/reaming/tapping, etc. 
       DRILL    similar to G81 fixed cycle 
       FACE IPM   similar to G82 fixed cycle 
    CYCLE/  TAP, z,  IPR, f, r  similar to G84 fixed cycle 
       BORE MMPR  similar to G86 fixed cycle 
       REAM MMPM  similar to G85 fixed cycle 
     z is the dept, f is the feed rate and r is the rapid plane. 
    CYCLE/  ON  actuates the previous cycle. 
       OFF  suppress the cycle command (similar to 
G80) 
LOADTL/ is used to load tool of specified number from the specified tool 
magazine 
   position. 
    LOADTL/ tool no., magpos 
THREAD/ is used to activate the threading mode. 
       FACE 
    THREAD/ TURN, INCR, a, TPI,  p, DEPTH,  d 
       TAPER DECR MMPR 
     a indicates the rate that which pitch of the thread changes. For  
         constant pitch threads this can be omitted.  
     p is the pitch in threads per inch or mm per revolution. 
PRINT/  is used to print required information on the line printer. 
    PRINT/ ON or PRINT/ALL 
    PRINT/ OFF 
CLPRINT/ is used to print the cutter location data. 
    CLPRINT/ ON  
    CLPRINT/ OFF 
REMARK/ is used to add comments for clarity of the program. 
    REMARK/  comment 
FIN/   is used to indicate the finishing of the program (similar to END 
command). 
 

PROGRAM  EXAMPLE 

 
 
PART NO/ MILLING JOB NO.1 
REMARK PROGRAMMER – B.SATYANARAYANA 
MACHINE / STARMILL 
REMARK / GEOMETRICAL DEFINITIONS 
CLPRINT / ON  $$ prints CL data. 
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REMARK / GEOMETRIC STATEMENTS 
SP=POINT/–4.0, –4.0 
P1= POINT/–2.0 
Q1=POINT/0, 0 
Q2=POINT/4, 0 
Q3=POINT/0,4.0,6.0 
CL12=LINE/XAXIS 
CL13=LINE/YAXIS 
L1=LINE/PARLEL, CL13, XSMALL, 2.0 
L2=LINE/PARLEL, CL13, XLARGE, 2.0 
L3=LINE/PARLEL, CL12, YLARGE, 2.0 
L2=LINE/PARLEL, CL12, YSMALL, 2.0 
C1=CIRCLE/CENTRE, Q3, RADIUS, 2.0 
C2=CIRCLE/CENTRE, Q2, RADIUS, 2.0 
C3=CIRCLE/CENTRE, Q1, RADIUS, 2.0 
Q11=POINT/0,0,–5.0 
Q21=POINT/4,0,–5.0 
Q31=POINT/0,4.06,–5.0 
PS=PLANE/Q11, Q21, Q31 
REMARK / MOTION STATEMENTS 
FROM/SP 
CUTTER/16 
TOLER/0.05 
SPINDL/RPM, 600, CLW 
COOLNT/ON 
FEDRAT/MMPM, 100 
GO/TO, L1, T0, PS, TANTO, C3 
AUTO PS 
GODLT/–10.0 
TLLFT 
GOFWD/L1, TANTO, C1 
GOFWD/C1, TANTO, C2 
GOFWD/L2, L3 
GOFWD/L3, TANTO, C2 
GOFWD/C2 
GOFWD/L4 
GOFWD/C3, TANTO, L1 
GOFWD/10.0 
RAPID 
GOTO/SP 
COOLNT/OFF 
SPINDL/OFF 
CLPRINT/OFF 
END 
FINI 
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4. MACHINING OF ONE JOB ON CNC MACHINE TOOL 
 

    FIG NO : 1 
 
EXAMPLE 1 
 
[ BILLET X 20 Z 80; 

G28 

M06 T03 ; 

M03 S1500 F90 ; 

G00 X20  Z1 ; 

G71 U0.2  R0.5 ; 

G71 P10 Q 20 U0 W0 ; 

N10 G01 X0 ; 

Z0; 

G03 X10 Z-5 R5 

EXAMPLE NO: 2  

 
FIG NO : 2 
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[ BILLET X 20 Z 60; 

M06 T03  G28 ; 

M03 S1500 F90 ; 

G00 X21  Z1 ; 

G71 U0.2  R0.5 ; 

G71 P10 Q 20 U0.1 W0 ; 

N10 G01 X0 ; 

Z0; 

G01 X13 Z0 R0 ; 

G01 Z-10 ; 

G01 X16 Z-10 ; 

G01 Z-20; 

G01 X19 Z-20 ; 

N20 G01 Z-30; 

G28 M03 ; 

 
 

CAM VIVA QUESTIONS 
1. What is NC part programming? 
2. In NC part programming “BLOCK” means? 
3. In NC part programming data contains in the form of? 
4. How many types NC part programming is prepared? 
5. Manual part programming is prepared on? 
6. Give one example to prepare NC part programming using computer language? 
7. What are G, N, and M codes? 
8. Explain each term given below NC program 

N001 G02 X023 Y024 R5 M03 
9. For circular interpolation which preparatory code is used? 
10. How many number of “ dimension numbers” required for NC part 

programming? 
11. How many digits used to represent feed word? 
12. How many digits used to represent spindle speed word? 
13. How many digits used to represent tool word? 
14. What is magic-three code? 
15. What is different between G00 and G01? 
16. What is different between G90 and G91? 
17. What is cutter compensation? Which codes are used for cutter compensation? 
18. Explain canned cycle or fixed cycle? Which codes are used for cycle or fixed 

cycle? 
19. Expand BLU? 
20. Explain different types of tool paths used in NC part programming? 
21. Explain co-ordinate system for CNC turning? 
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22. Explain co-ordinate system for CNC milling? 
23. Expand and explain APT? 
24. How many types of statements used APT programming? 
25. Explain and classify motion statements in APT programming? 
26. How many types point, circle and line represented in APT programming using 

geometrical statements? 
27. Explain point-to-point motion statement and sketch? 
28. Explain contour motion statement with sketch? 
29. What is postprocessor in APT programming? 
30. What is CNC? 
31. What is DNC? 
32. For plane selection which preparatory codes used? 
33. Expand and explain ATC? 
34. What is difference between incremental and absolute system? 
35. What is difference between absolute zero and floating zero co-ordinate 

system? 
36. Explain difference between point-to-point, linear and contour interpolation? 
37. G04 represents which operation in NC part programming? 
38. Explain difference between NC, CNC, and DNC? 
39. Which preparatory code is used for tool nose radius compensation in turning? 
40. What are different types of CNC controllers is used in now days? 
41. Polar co-ordinate systems are CNC programming or not?  
42. Explain High speed machining? 
43. What are functions of adaptive control system in CNC machines? 
44. Explain different parts in NC machines? 
45. Explain different steps from design to manufacturing using NC machines? 
46. What is CNC turning center? 
47. What is difference between ATP and ATC? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


